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Lync 2013 Gateway v2.3 Software 
Installation Guide
Purpose

This document provides instructions for installing the VBrick Lync Streaming Gateway 
software on hardware you did not purchase from VBrick. Table 1 shows required hardware 
and software components. 

Required Hardware and Software

Table 1.  Minimum Streaming Gateway Server Requirements

†   for access to support software. 

Table 2.  Additional Server Requirements

Note These instructions only apply if you purchased a software-only version of this product. 
If you purchased both hardware and software from VBrick, please contact VBrick 
Support Services (or your certified reseller) for help installing the Lync software and 
integrating the server into your environment. 

Hardware/OS Component Minimum Requirement

CPU • 64 bit, dual processor, quad-core 2.0 GHz+
• 64 bit, 4-way processor, dual-core 2.0 GHz+

Operating System 64 bit – Windows Server 2012 Standard

Memory 8 GB

HDD Local storage with at least 30 GB free disk space

Network 2 x 1 Gbps network adapter

Software Media • 64 bit – Microsoft Lync Server 2013 DVD †
• VBrick 2013 Streaming Gateway CD / 

Download

Server Minimum Requirement

Additional Servers • Server – Microsoft Lync Server 2013
• Server – Microsoft Exchange 2013
• Server – VEMS 6.3.6 or later
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Table 3.  Desktop Requirements

†   only 32 bit client currently supported.

Pre-Installation Steps

• Be sure you have the VBrick Product CD and the Microsoft Lync Server Product CD 
(see above). 

• Be sure that all items in Chapter 2 of the Lync Streaming Gateway Admin Guide have been 
completed. This includes creating:
• a service account. 
• the "VBrick Video" distribution group.
• the administrative group for Video Blast.

• Configure the server on the domain. Assign a hostname for the server as desired, and 
configure the appropriate IP settings to join it to the customer's domain.

• Update the VBrick Lync Streaming Gateway Server. .NET 3.5 SP1, .NET 4.5 and 
Windows PowerShell v3 are required for the VBrick Lync Streaming Gateway software.

1.  Install .NET 3.5
1. Verify that you can get to the Internet. 
2. Install windows updates (repeat several times if necessary, i.e. until the server is 

completely up-to-date).
3. Verify that .NET Framework 3.5 SP1 is installed (it will be listed as an installed program). 

If not installed, follow these steps: (Note: to open the Server Manager interface, right 
click on Start > Computer and select Manage.)
a. In the Server Manager interface, select Add Features to display a list of possible 

features.
b. In the Select Features interface, expand .NET Framework 3.5.1 Features.
c. Once you expand .NET Framework 3.5.1 Features you will see two check boxes: one 

for .NET Framework 3.5.1 and one for WCF Activation. Check the box next to .NET 
3.5.1 Framework and click Next.

Note: If you do not expand .NET Framework 3.5.1 Features and check it, you will get a 
pop-up titled Add Features Wizard as shown below. If this happens, click Cancel, expand 
.NET Framework 3.5.1 Features and then check .NET Framework 3.5.1 box at the bottom. 
You cannot install .NET Framework 3.5.1 features unless the required role services and 
features are also installed.

Hardware/OS Component Minimum Requirement

Windows Client PCs • Windows 2008 R2 / 7 / 8 / 8.1
• Microsoft Lync 2013 Client 32 bit †
• Microsoft Windows Media Player 9.0 or higher
• Microsoft Internet Explorer 8.0 or higher
• VBrick Video Buddy VEMS Client Add-On

Note The following steps guarantee that all components get installed. However it may be 
faster to download the installer for .NET 3.5 SP1 or use some other method.
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4. In the Confirm Installation Selections interface, review the selections and click Install.
5. Allow the installation process to complete and then click Close.

2.  Install .NET 4.5
.NET 4.5 is required for the VBrick Lync 2013 Streaming Gateway software. It can be 
installed by downloading from the internet as follows:
1. Open a web browser. 
2. Navigate to http://www.microsoft.com/en-us/download/details.aspx?id=30653 
3. Download and run dotNetFx45_Full_setup.exe 
4. Use the default settings.

3.  Install "Desktop Experience" Feature
1. Open the Server Manager. 
2. Select Add Features. 
3. Check the box for "Desktop Experience."
4. Install using the default settings.

4.  Install PowerShell 3.0
1. Open a web browser. 
2. Navigate to http://www.microsoft.com/en-us/download/details.aspx?id=34595 
3. Download and run Windows6.1-KB2506143-x64.msu 
4. Use the default settings. 

5.  Install Lync 2013 Administrator Tools
Install Lync 2013 Administrative Tools (from Lync 2013 Server DVD). The VBrick Lync 
Streaming Gateway software requires components from the Lync Administrative Tools. Make 
sure you have Lync Product CD on hand. 
1. Insert Microsoft Lync Server 2013 DVD or install media. 
2. Browse to the DVD. 
3. Navigate to folder on the DVD ‘Setup\amd64’ 
4. Run setup.exe
5. Click Next and accept the default settings.
6. If prompted to install the "Microsoft C++ 2012 Redistributable" select "Yes."

http://www.microsoft.com/en-us/download/details.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=34595
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7. If prompted to select an installation location, use the default.
8. Accept the "Terms & Conditions."
9. Select "Install Administrator Tools," accept the license agreement and complete the 

install. When finished, exit the "Deployment Wizard." 

6.  Install UCMA 4.0
Install the UCMA 4.0 Redistributable. The VBrick Lync Streaming Gateway software requires 
components from the Microsoft Unified Communications Managed API SDK. These 
components are installed via the UCMA Redistributable.
1. Browse to the \software\Admin folder on the Product CD. 
2. Double click on the file UcmaRuntimeSetup.exe and let it complete the configuration.
3. Accept the Terms & Conditions and use the default settings.

7.  Verify Powershell
Verify that Windows PowerShell v3 is installed as required.
1. Select Start > Administrative Tools > Windows PowerShell Modules to open PowerShell.
2. Wait for the prompt (may take several seconds).
3. Type "$Host.Version"
4. Verify that the value return is "3 0 -1 -1"
5. Type "Exit."

8.  Obtain Security Certificates
Obtain Security Certificates. For proper communications between the VBrick Lync 
Streaming Gateway Server and the Active Directory, the necessary security certificates must 
be installed. Install Computer Certificate on Application server machine.
1. Start Certificates MMC snap-in by going to the Start Screen, type "mmc", then press the 

Enter key.
2. When the empty Console1 window opens, choose File > Add/Remove Snap-in.
3. When the Add Standalone Snap-in window opens choose Certificates and click the Add 

button.
4. When the Certificates snap-in window opens, check the Computer account radio-button, 

and then press the Next button:
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5. When the Select Computer window opens choose Local computer and press the Finish 
button. 

6. Then press Finish, Close, OK buttons as you return to the MMC interface.
7. On the MMC screen, expand "Certificates (local computer)" > "Trusted Root Certificate 

Authorities." Click on the "Certificates" sub category under "Trusted Root Certificate 
Authorities."

8. Verify that there is a certificate issued by the domain’s Certificate Authority ("vblync-
LDC-CA" in the example below).
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9. If there is no certificate issued by the domain’s Certificate Authority (CA) then one must 
be obtained. Coordinate with the customer’s IT personnel to obtain the trusted root 
certificate.

10. On the MMC screen, expand "Certificates (local computer)" > "Personal."
11. Right click on "Personal" and from the menu go to "All Tasks" > "Request New 

Certificate."

12. From the "Before You Begin" screen click "Next."

13. Select the default "Enrollment Policy" (Active Directory Enrollment Policy) and click 
Next. 

Note This next step is to obtain a Personal Certificate. This certificate must have both 
Server Authentication and Client Authentication.
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14. Select the checkbox next to "Computer" and click "Enroll."
15. Note: If the "Computer" template is not available, check the box named "Show all 

templates." A list of templates will then be displayed. If the "Web Server" template is 
available use this template. If neither template is available, coordinate with the customer’s 
IT personnel to obtain a Personal Certificate which has both Server Authentication and 
Client Authentication.
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16. Upon enrolling, the system should obtain a new "Personal Certificate" from the CA. If 
successful, click "Finish." Verify that the certificate is available by navigating through the 
certificate folder structure to Certificates (local computer) > Personal > Certificates.

17. Issued By. Write down the "Issued By" value of the Personal Certificate. This 
information will be needed later.

18. Issued To. Write down the "Issued To" value of the Personal Certificate. This 
information will be needed later.

19. Thumbprint
a. Double-click on the new Personal Certificate
b. Click on the "Details" tab
c. Select the "Thumbprint" field

Note Please record this information on the Integration Worksheet provided in the Admin 
Guide.
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d. Copy & paste the value displayed into Notepad and save the file (you will need this 
value later in the installation)

e. Right click on the new certificate and select "All Tasks" > "Manage Private Keys."
f. Click the "Add" button on the permissions window that appears.

20. In the Select Users, Computers, or Groups window in the field titled "Enter the object 
names to select", enter domain\username where this is the domain and username of the 
service account created in step #2 of the Admin Guide. In the example below, this is 
"vblync\lyncvbservice."   Click "Check Names." The result should look like the image 
below:
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21. Click "OK" to return to the previous window. It should now look like the image below:

22. Click "OK" to close the window.
23. Close the console window. If prompted to save, say "No."

9.  Create a New Trusted Application Pool and Application
The purpose of this section is to create a Trusted Application pool and a Trusted Application 
associated to that pool. In Lync all these are created/provisioned using PowerShell. 
PowerShell 3.0 is a required component. When you install the UCMA 4.0 Redistributable it 
would have installed the necessary modules for PowerShell to interact with Lync modules. 
1. On the Lync server, open the Lync Server Management Shell (Start > All Programs > 

Microsoft Lync Server 2013 > Lync Server Management Shell).
2. Run the command: get-CsSite. This command will provide information about the Lync 

site.
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:

3. Make a note of SiteId, Pools and Registrar. The pool and registrar could normally be the 
same (usually the name of the pool itself). In the case of a Lync Standard Edition, it 
could be the FQDN of the Front End server itself.

4. Run the Command: New-CsTrustedApplicationPool -Identity <myFQDN> -Registrar 
<poolFQDN > -Site <siteID> 
• <myFQDN> – FQDN of Gateway server, i.e. STRGW2008R2.vblync.com
• <poolFQDN> – FQDN of pool, i.e. pool.vblync.com
• <siteID> – Site ID from get-CsSite command

5. Run the command: New-CsTrustedApplication -ApplicationId lyncvideobuddy 
-TrustedApplicationPoolFqdn <myFQDN> -Port 6050

<myFQDN> – FQDN of server, i.e. vblyncgw.vblync.com
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6. Run the command: Enable-CsTopology 

7. Run the command: Get-CsTrustedApplication and review the displayed information for 
accuracy.

8. Run the command: Get-CsTrustedApplicationPool and review the displayed information 
for accuracy.
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9. Type "Exit."

10.  Install the Services
1. Navigate to VBLync2013StreamingGW folder on the Product CD.
2. Run setup.exe. Select the default values on the installation screens. 
3. During the service installation you will twice be requested to enter the credentials of the 

service account. Enter the username and password of the "lyncvbservice@domain" 
account created in step #2 of the Admin Guide.

4. Once installation is complete, navigate to the Windows Service Manager (Start > 
Administrative Tools > Services).

5. Find the "VBrick OCS Video Buddy BOT Service," right-click on it, and select 
"Properties." Click on the "Recovery" tab. Update the Recovery parameters as shown 
below. 

6. Repeat Step 5 above for the “VBrick OCS Video Buddy VEMS Interface Service”. 
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11.  Installing VB Alert Admin Tool
1. Navigate to the \VBAlertAdminSetup folder on the Product CD.
2. Run VBAlertAdmin.msi. Select the default values on the installation screens.

12.  Installing VB Configuration Administration Tool
1. Navigate to the \VBConfigTool folder on the Product CD.
2. Run VBConfigToolSetup.msi. Select the default values on the installation screens.

13.  Configure the VB VEMS Interface Service
1. Open the VBrick Video Buddy Configuration Tool.
2. Select Start > VBrick Video Buddy Configuration Tool.
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3. Click "Browse."
4. Navigate to C:\Program 

Files\VBrick\Lync2013StreamingGW\VBVEMSInterfaceService.
5. Double-click on VBVEMSInterfaceService.exe.config
6. Modify the configuration settings as follows:

a. OcsAdminUserName – Set to the username of the VEMS account being used by the 
server to access VEMS content. The recommended/default settings is "lyncadmin."

b. OcsAdminUserPassword – Set to the password of the VEMS account being used by 
the server to access VEMS content, i.e. the password for the username specified by 
OcsAdminUserName.

c. VemsIpAddress – Set to the IP address of the VEMS server.
d. MystroServiceUrl – Modify the hostname specified in the URL to reference the 

hostname of the VEMS server, i.e. change "maduro" to the VEMS hostname.
e. SIPDomainForVBContacts – Modify to specify the desired SIP domain on which 

the Video Buddies will be created.
f. MystroAutomatonCustomFieldName – Specifies the name of the custom field in 

VEMS Mystro which is used to determine if a Video Buddy is an automaton or not.  
The value of the custom field should be "yes" to indicate it is an automaton and "no" 
to indicate it is not. 

7. Save your changes.

14.  Configure the VB BOT Service
1. Select "Browse" from the VBrick Video Buddy Configuration Tool.
2. Navigate to C:\Program Files\VBrick\Lync2013StreamingGW\VBBOTService.
3. Double-click on VBBOTService.exe.config.
4. Modify the configuration settings as follows:

a. VB_MYSTRO_PLAYER_PAGE – Modify the hostname specified in the URL to 
reference the hostname of the VEMS server, i.e. change "maduro" to the VEMS 
hostname.

b. SIPDomainForVBContacts – Modify to specify the desired SIP domain on which 
the Video Buddies will be created.

5. Save your changes. 



16 © 2014 VBrick Systems, Inc.

Configuring Video Buddies

When configuring the VB Bot Service and the VB VEMS Interface Service you will need to 
specify where your Video Buddies are defined using the VideoBuddySource parameter. If your 
Video Buddies are sourced from a VEMS server, you simply need to enter VEMS5.x or 
VEMS6.0 as appropriate. You can also define your Video Buddies in an .xml file. If using an 
.xml file, you can create the file manually (see example below) or you can use the template 
which is located in: C:\Program Files\VBrick\templates\template.xml. When done, the 
XMLLocation will point to the location where this file is saved. 

Creating a Video Buddy .xml File

 To create and use an .xml file for Video Buddy definitions:

1. Create a text file in Notepad or a similar editor or simply copy/edit the template. See 
sample file below.

2. Create a separate entry for each Video Buddy and save the file in a known location that 
can be reached by the server—either local or remote.

3. Specify the complete path to this location in the XMLLocation key in the VB VEMS 
Interface Service (see 13.  Configure the VB VEMS Interface Service on page 14).

Sample .XML File
<VideoBuddies>
   <VideoBuddy>
       <Number>36</Number> 
       <Name>RemoteXML</Name> 
       <Program>Remote XML Test</Program> 
       <Active>YES</Active> 
       <Status>UP</Status> 
       <Automation>NO</Automation> 
       <URL>http://vbosstv.com/wpa/ocs.html</URL> 
   </VideoBuddy>
</VideoBuddies>

Parameter Description

Number Unique channel number. 

Name Name of Video Buddy. 

Program Current program, e.g. "Larry King Live."

Active Yes = Video Buddy exists. 
No = Video Buddy does not exist.

Status Up = video stream is up.
Down = video stream is down. 

Automation Yes = Video Buddy presence will not change.
No = Video Buddy presence will change when changed in XML file. 

URL Fully qualified URL to a web page with a video player.
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Configuring Presence Options 

In a standard Lync Streaming Gateway installation, Video Buddy presence icons are used to 
indicate the availability of a stream. However due to certain constraints in the Microsoft Lync 
Server, you may need to change this default behavior if more than 600 concurrent users are likely to 
have the same Video Buddy on their desktop. There are three configurable behaviors (see 
Table 4) associated with Video Buddy presence icons: in the standard (default) scenario, the 
presence icons change color according to the status of the stream (available or offline) and 
each stream will have a unique title; in the modified scenario, the presence icons are always 
green and each stream will always have the same title.

Figure 1.  Video Buddy Presence Icon

Table 4.  Presence Icon Behavior 

Note In the standard (default) scenario, the presence icons change color according to the 
stream status (available or offline) and each stream has a unique title. If you wish to 
change this behavior you should do so in advance, before rolling out the Video Buddy 
functionality for users. 

Option Description

Dynamic Presence Default behavior (less than 600 users). The presence icons change color 
depending on the availability of the stream. The stream title is different for 
each stream and is configured in VEMS. See "Adding Gateway Streams. 

 (green) – Available (or current program title) 
 (orange) – Offline
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As noted, the default behavior shown in Table 4 is configured by default. If you expect to 
have less than 600 concurrent users with the same Video Buddy on their desktop, no further 
action is required and you are good to go. If however you expect to have more than 600 users 
with the same Video Buddy you will need to modify two parameters in the VB Bot Service as 
explained below. 

Table 5.  VBBOTService.exe.config 

Static Presence Modified Behavior (more than 600 users). The presence icons are always 
green. The stream title is the same for all streams and is configured in the 
Lync Gateway server. See 14.  Configure the VB BOT Service on page 15. 

 (green) – Available 

Mixed Presence A configuration setting is used to determine on a per-stream basis whether 
or not the presence behavior is "static" or "dynamic." In this scenario, the 
"IsVBContactAutomaton" must be set to "no." For each stream, the value 
of the custom field in VEMS Mystro (as specified in the VEMS Mystro 
Interface Service) is checked. If the custom field is "yes," then the stream 
will exhibit static behavior. If the custom field is not "yes," the stream will 
exhibit dynamic behavior. If no custom field is defined, all streams will 
exhibit dynamic behavior.  Note that if XML is used instead of VEMS 
Mystro, the XML attribute "Automaton" is used to specify the per-stream 
behavior. 

Logging Level Determine the amount of debugging information to include in the log 
files. The range of values are as follows:
1. Errors
2. Add Warnings
3. Add Informational Messages
4. Add Debug Messages
5. Add Full Tracing

LogFile Name of the file where logging information is stored.

LogDirectory Folder where the log file is written to.

MaxLogFileSize The maximum size (in MB) of each log file (after which a new log file 
will be created). Max = 25MB.

MaxLogFiles The maximum number of log files that will be created by the service

ProcessChannelInterval
InMinutes

Frequency (in minutes) with which the Video Buddy server updates it’s 
list of channels (Video Buddies).

NewEndPointEstDelayInM
inutes

Number of minutes required for a new Video Buddy to be 
synchronized.

UCReestablishDelayInMi
nutes

Frequency in which the server attempts to recover from detected 
failures, such as the Lync Server being down. 

VB_VIDEO_PLAY_MESSAGE This field indicates the text which a user must enter to initiate video 
streaming with a Video Buddy. This text string must be entered at the 
beginning of a chat window. Entering this text is only required if the 
client add-on has not been installed on the client desktop.

VB5.x_PLAYER_PAGE Deprecated. 

Option Description
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15.  Configure the Certificate Settings (VB BOT Service)
1. Open the Notepad file containing the Thumbprint value saved previously
2. Edit the file C:\Program 

Files\VBrick\Lync2013StreamingGW\VBBOTService\VBBOTService.exe.config in 
Notepad.

3. Under <applicationSettings> modify the settings as follows:
a. Set CertificateIssuer to the "Issued By" value of the Personal Certificate (vblync-

LDC-CA in the example below).
b. Set CertificateIssuedTo to the "Issued To" value of the Personal Certificate 

(lyncgw.vblync.com in the example below).
c. Open the file containing the Certificate Thumbprint saved earlier. Copy and paste 

the value into the CertThumbprint value (00000000… in the example below).

  <applicationSettings>
    <VBrick.OCSVideoBuddy.VBBOTService.Properties.Settings>
      <setting name="ApplicationName" serializeAs="String">
        <value>LyncVideoBuddy</value>
      </setting>
      <setting name="CertificateIssuer" serializeAs="String">
        <value>vblync-LDC-CA</value>
      </setting>
      <setting name="CertificateIssuedTo" serializeAs="String">
        <value>lyncgw.vblync.com</value>
      </setting>
      <setting name="CertThumbprint" serializeAs="String">

VB_MYSTRO_PLAYER_PAGE This field specifies the URL that the Lync client will use to load the 
VBrick player for the specified Video Buddy and user. The identifying 
information for the Video Buddy and use are dynamically inserted into 
this URL.

EncodeSpecialCharacter
s

Determines how special characters are encoded. Should not be 
modified.

VideoBuddySource Depending on where the Video Buddy definitions are retrieved from, 
set this parameter to: VEMS 5.X, MYSTRO, or XML.

SIPDomainForVBContacts The customer's SIP domain. For example, if the end user logs in as 
harry.potter@lync.com, the SIP domain is "lync.com."

XMLLocation For XML, modify this parameter to reference the location of the .xml 
definition file. 

IsVBContactAutomaton Default = False. This field indicates if Video Buddies should be created 
as automatons. When Video Buddies are created as automatons, the 
presence color is always green and the status description is always the 
same (see VBAutomatonContactStatusMessage below).

VBAutomatonContactStat
usMessage

Default = Video. Indicates the text which should be displayed for a 
Video Buddy which has been created as an automaton. This text will 
always be displayed for all Video Buddies which have been created as an 
automaton.

VBApplicationGUID Unique identifying ID of the client-side application. It should not be 
necessary to change this value. 
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        <value>0000000000000000000000000000000000000000</value>
      </setting>
    </VBrick.OCSVideoBuddy.VBBOTService.Properties.Settings>
  </applicationSettings>

4. Save and exit Notepad.

16.  Configure the Certificate Settings (VB VEMS 
Interface Service)

1. Open the Notepad file containing the Thumbprint value saved previously
2. Edit the file C:\Program 

Files\VBrick\Lync2013StreamingGW\VBVEMSInterfaceService\VBVEMSInterfaceSe
rvice.exe.config in Notepad.

3. Under <applicationSettings> modify the settings as follows:
a. Set CertificateIssuer to the "Issued By" value of the Personal Certificate (vblync-

LDC-CA in the example below).
b. Set CertificateIssuedTo to the "Issued To" value of the Personal Certificate 

(vblyncgw.vblync.com in the example below).

  <applicationSettings>
    <VBrick.OCSVideoBuddy.VBVEMSInterface.Properties.Settings>
      <setting name="ApplicationName" serializeAs="String">
        <value>LyncVideoBuddy</value>
      </setting>
      <setting name="CertificateIssuer" serializeAs="String">
        <value>vblync-LDC-CA</value>
      </setting>
      <setting name="CertificateIssuedTo" serializeAs="String">
        <value>vblyncgw.vblync.com</value>
      </setting>
      <setting name="VEMSService_VemsSdk_MCSWebSDK" serializeAs="String">
        <value>http://vems.vblync.com/MCSWebSDK/MCSWebSDK.asmx</value>
      </setting>
    </VBrick.OCSVideoBuddy.VBVEMSInterface.Properties.Settings>
  </applicationSettings>
</configuration>

17.  Give Port Permissions to the Services
By Default, Windows 2008 Server will not allow access to the http ports needed by the 
VBrick Lync Streaming Gateway services. The follow commands allows access to the 
necessary port.
1. From the "Start" menu, launch a command prompt window.
2. From the command prompt, enter the following command with the user specified being 

the domain/username of the service account specified in step #2 of the Admin Guide. 
In the example below, the domain/username is "vblync.com\lyncvbservice." 

netsh http add urlacl url=http://+:8000/ user=vblync.com\lyncvbservice

3. If successful, you should see the response "URL reservation successfully added".
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18.  Open Required Ports in the Firewall
By default, Windows 2008R2 Server firewall blocks necessary VBrick Lync Streaming 
Gateway Server ports. We must open one.
1. Select Start > Control Panel.
2. Click "Check Firewall Status" (or "Windows Firewall").
3. Click on "Advanced Settings."
4. Click on "Inbound Rules."
5. Click on "New Rule."
6. Select "Port" then "Next" to open the "New Inbound Rule Wizard."
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7. Select "TCP" and "Specific local ports", then enter "6050." Click "Next."

8. Check "Allow the connection" and hit "Next."
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9. Check "Domain." Uncheck "Private" and "Public." Click "Next."

10.  Type in "Lync Video Buddy"
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11.  Click "Finish."
12.  Verify that the new rule is listed.

19.  Configure the Software Version Number and Serial 
Number

 To configure the software version:

1. Navigate to the \admin folder on the Product CD.
2. Double-click on "SetVersion.bat"

 To enter the serial number: 

1. Navigate to the \admin folder on the Product CD.
2. Double-click on vbOCSSerialNumberUpdate.exe 
3. Enter the "software-only" serial number (with hyphens) from the "Welcome to VBrick" 

customer letter that was shipped with your order.
4. Click Save and Close.

20.  Restart the VBrick Lync Streaming Gateway Server
From the "Start" menu, reboot the server. Installation and configuration are complete. 

21.  Troubleshoot

The “Request new certificate” option is not available.

• Possible Solution: Verify that the Streaming Gateway Server is on the domain.
• Possible Solution: Verify that you are logged into the Streaming Gateway Server as a 

domain admin (it is easy to log in as the local admin by accident).

When requesting the Personal Certificate I don’t see a checkbox.

• Possible Solution: Verify that the Streaming Gateway Server is on the domain.
• Possible Solution: Verify that the Streaming Gateway Server has the Trusted 

RootCertificate from the Certificate Authority for the domain.

Application Provisioner tool crashes or will not create an Application Pool.

• Possible Solution: Verify that you are logged in as the LyncVBService user when 
attempting to use the Application Provisioner tool.

• Possible Solution: Verify that the LyncVBService user is part of the groups 
"RTCUniversalServerAdmins" and "RTCUniversalUserAdmins"
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The VB Bot Service fails to start.

If the service fails to start, it is always helpful to increase the logging level for that service.

 To increase the logging level:

1. Open the configuration file using the "VBrick Video Buddy Configuration Tool" and set 
the "Logging Level" to 5. This will enable very robust logging. Remember to turn it 
back to 3 when done to reduce log file size.

2. Once the logging level is set to 5, delete or backup and remove the old log files for the 
VB Bot service. By default, log files are located in "C:/ProgramData/VBrick" which is a 
hidden folder.

3. Attempt to start the service.
4. If it fails again or has problems of any sort, review the log files which should have just 

been created.
5. The errors should be displayed. Verify that there are no typos in the configuration, and 

that all FQDNs are accurate. Common errors for the VB Bot service are typically errors 
in the configuration file relating to the "Issued To" and "Issued By" sections (see Step 4 
on page 23).

The VB VEMS Interface Service fails to start.

If the service fails to start, it is always helpful to increase the logging level for that service.

 To increase the logging level:

1. Open the configuration file using the "VBrick Video Buddy Configuration Tool" and set 
the "Logging Level" to 5. This will enable very robust logging. Remember to turn it 
back to 3 when done to reduce log file size.

2. Once the logging level is set to 5, delete or backup and remove the old log files for the 
VB Bot service. By default, log files are located in "C:/ProgramData/VBrick" which is a 
hidden folder.

3. Attempt to start the service.
4. If it fails again or has problems of any sort, review the log files which should have just 

been created.
5. The errors should be displayed. Verify that there are no typos in the configuration, and 

that all FQDNs are accurate. Common errors for the VB Bot service are typically errors 
in the configuration file relating to the "Issued To" and "Issued By" sections.

New Video Buddies can’t be found when searching for them on the Lync client.

• Possible Solution: Verify VB Bot Service and VB VEMS Interface Service are running
• Possible Solution: Check the log files for the VB Bot Service and the VB VEMS 

Interface services to see if they are experiencing problems
• Possible Solution: The timer settings in the VB Bot Service and VB VEMS Interface 

Service configuration files introduce delay in creating new buddies. The default 
configuration settings may introduce up to a 30 minute delay in creating a new Video 
Buddy. The reason for this is to keep unnecessary load to a minimum on both the 
VBrick VEMS server and the Lync system. While VBrick suggests using the default 
delay settings, you may modify the delay settings for both services as needed.
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I can’t find the “VBrickVideo” distribution group to add to my Lync client.

• Possible Solution: If you have just recently created the VBrickVideo distribution group 
it may take up to 24 hours for Lync to make that group available to Lync Clients.

My “VBrick Video” distribution group is not populating with new Video Buddies.

• Possible Solution: It may take up to 24 hours for the Lync system to update the 
distribution group on the client. This is an Lync behavior and is not related to the 
VBrick VEMS Lync Streaming Gateway Server.
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